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01. INSTALLATION ET DÉSINTALLATION DU LOGICIEL 01. INSTALLATION ET DÉSINTALLATION DU LOGICIEL

ÉTAPES D'INSTALLATION DE BASE CONFIGURATION LOGICIEL

CONFIGURATION LOGICIEL

01 • Installez le logiciel Access Control.

02 • Cliquez sur  "Next".

03 • Cliquez sur "Next".

04 • Cliquez sur  "Next".

01 • En premier insérez d’abord le CD dans le CD-ROM, puis exécutez l’application "setup.exe" ou via 
notre bibliothèque Web en téléchargeant le dossier du logiciel, puis exécutez l’application "setup.exe", 
située à logiciel.

Mémoire: 1 GB.
Disque Dur: 1 GB au dessus de l'espace libre. 

• Windows 7
• Windows 10

EXIGENCES D'INSTALLATION DE BASE

FONCTIONNEMENT DU SYSTÈME SUPPORTÉ PAR LOGICIEL
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CONFIGURATION LOGICIEL

RETIRER LE LOGICIEL

RETIRER LE LOGICIEL
01 • Cliquez sur "Démarrer" et tapez "Panneau de configuration".
02• Cliquez sur "Désinstaller un programme" .

03 • Recherchez le logiciel "Access Control" et cliquez sur "Désinstaller".

04 • Cliquez sur "Oui".

05 • Cliquez sur  "Close".
Une fois l' installation terminée, il sera créé         automatiquement et affiché sur l'écran de votre 
ordinateur.

01. INSTALLATION ET DÉSINTALLATION DU LOGICIEL 01. INSTALLATION ET DÉSINTALLATION DU LOGICIEL
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02. FONCTIONNEMENT DE BASE DU LOGICIEL 02. FONCTIONNEMENT DE BASE DU LOGICIEL
DEMARRER SESSION DEMARRER SESSION
Cliquez                ou exécutez Démarrer > Programmes >  Access Control > Access Control, la fenêtre de 

connexion s'ouvre comme suit:

Utilisateur: abc
Mot de passe: 123
Il est recommandé de changer votre nom d'utilisateur et votre mot de passe après la première utilisation.

Si la connexion SQL Server échoue. La boîte de dialogue précédente apparaîtra.
01 • Cliquez sur "Ok". Veuillez vous reporter à l’Annexe Configuration du serveur SQL.
Après la connexion, la fenêtre principale apparaîtra comme suit:

CONFIGURATION DES PARAMÈTRES DE L´ÉQUIPEMENT
AJOUTER / CONFIGURER LE CONTRÔLEUR
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01 • Cliquez sur Configuration > Controllers dans la barre de menus.
02 • Cliquez sur le bouton "New" pour ajouter les pilotes au système.

Le numéro du contrôleur (il s’agit du numéro de série du contrôleur) figure sur l’étiquette S / N: ********* 
du contrôleur. S' il vous plaît remplir les neuf chiffres.

“Door Name” et “Reader Position” peuvent être modifiés.
04 • Cochez "Active", la console affichera le port, sinon il ne sera pas affiché.
05 • Vérifiez "Attendance" afin que les enregistrements du lecteur de carte puissent être utilisés comme 
enregistrements de présence, sinon ils ne le seront pas.
06 • Cliquez sur "Ok".

03 • Cliquez sur "Next".

02. FONCTIONNEMENT DE BASE DU LOGICIEL 02. FONCTIONNEMENT DE BASE DU LOGICIEL
CONFIGURATION DES PARAMÈTRES DE L´ÉQUIPEMENT CONFIGURATION DES PARAMÈTRES DE L´ÉQUIPEMENT

Si le contrôleur S / N que vous avez écrit n'est pas identique à la balise S / N: *********, le 
logiciel ne peut pas communiquer avec le contrôleur.

Petit réseau : prend en charge la communication TCP / IP, tous les contrôleurs sont sur le 
même segment de réseau.

Réseau moyen ou grand ou Internet : prend en charge la communication TCP / IP avec 
différents contrôleurs de segment de réseau.
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AJOUTER / CONFIGURER IP

CONFIGURATION DES PARAMÈTRES DE L´ÉQUIPEMENT CONFIGURATION DES PARAMÈTRES DE L´ÉQUIPEMENT

01 • Cliquez sur "Search".

03 • Click "Ok".

Résultat, vous pouvez voir l'adresse IP.
04 • Cliquez sur "Next".

The controllers are separated into different network . Each controller must be assigned a unique IP 
address .

La recherche prendra environ 5 secondes.
02 • Cliquez sur"Configure".

Après avoir configuré l'adresse IP, vous pouvez définir les paramètres du contrôleur, l'adresse IP doit être 
affectée au contrôleur correspondant.

02. FONCTIONNEMENT DE BASE DU LOGICIEL 02. FONCTIONNEMENT DE BASE DU LOGICIEL
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FILTRE IP GÉRER LA ZONE DE CONDUCTEUR

CONFIGURATION DES PARAMÈTRES DE L´ÉQUIPEMENT CONFIGURATION DES PARAMÈTRES DE L´ÉQUIPEMENT

Pour des raisons de sécurité et qu'un seul ordinateur a accès à ce logiciel et à cette base de données, 
cliquez avec le bouton droit de la souris et sélectionnez "Filtre IP".

02 • Cliquez sur "Add Top" et écrivez dans la zone vide.

03 • Cliquez sur "Ok".
Résultat, vous pouvez voir la zone créée.

Entrez l'adresse IP autorisée et cliquez sur " Add Allowed IP" ou sur " Add Current PC IP".
01 • Cliquez sur "Only Update IP List"

01 • Faites un clic gauche sur le contrôleur puis cliquez sur "Zones".

02. FONCTIONNEMENT DE BASE DU LOGICIEL 02. FONCTIONNEMENT DE BASE DU LOGICIEL
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CONFIGURATION DES PARAMÈTRES DE L´ÉQUIPEMENT

04 • Cliquez sur "Add Branch" pour ajouter un nouveau emplacement sous la zone.
05 • Écrivez dans la zone vide et cliquez sur "Ok".
Résultat, vous pouvez voir l'emplacement que vous avez créé.

Fermez cette fenêtre.
05 •  Configurez la fenêtre Zone sur le contrôleur.

FONCTIONNEMENT DE LA SECTION ET UTILISATEUR ENREGISTRÉ

01 • Cliquez sur Configuration > Department dans la barre de menus.
02 • Cliquez sur le bouton "Add Top" pour ajouter un département.
03 • Écrivez dans la zone vide et cliquez sur "Ok".

AJOUTER UNE SECTION

02. FONCTIONNEMENT DE BASE DU LOGICIEL 02. FONCTIONNEMENT DE BASE DU LOGICIEL
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04 • Cliquez sur "Add Branch" pour ajouter une nouvelle sous-division au département.
05 • Tapez dans la zone vide et cliquez sur "Ok".
Résultat, vous pouvez voir la sous-division créée.

AJOUTER ET MODIFIER UN UTILISATEUR

01 • Cliquez sur Configuration > Personnel dans la barre de menus.
02 • Cliquez sur le bouton "Add" pour ajouter des utilisateurs.

03 • Tapez les zones "User ID" et "Name".
04 • Pour ajouter une photo à l'utilisateur, cliquez sur "Photo" et choisissez le fichier souhaité.
05 • Après avoir entré les informations dans ces champs utilisateur, cliquez sur "Add Next" pour que la 
fenêtre de présentation soit toujours ouverte et que vous puissiez saisir les informations d'un autre 
utilisateur. Si vous ne voulez pas ajouter d'autres utilisateurs, cliquez sur "Ok" et l'utilisateur a été ajouté 
au système.

FONCTIONNEMENT DE LA SECTION ET UTILISATEUR ENREGISTRÉ FONCTIONNEMENT DE LA SECTION ET UTILISATEUR ENREGISTRÉ

02. FONCTIONNEMENT DE BASE DU LOGICIEL 02. FONCTIONNEMENT DE BASE DU LOGICIEL
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FONCTIONNEMENT DE LA SECTION ET UTILISATEUR ENREGISTRÉ FONCTIONNEMENT DE LA SECTION ET UTILISATEUR ENREGISTRÉ
06 • Pour éditer l'utilisateur créé, cliquez sur "Edit".
Vous pouvez ajouter plus d' informations via le sous-menu "Others".

Résultat, vous verrez les cartes d' inscription.
04 • Cliquez sur "Ok" à la fin de l'opération. Les cartes d'enregistrement seront ajoutées au système.

AJOUTER AUTOMATIQUEMENT UNE CARTE D'ENREGISTREMENT

01 • Cliquez sur Configuration > Personnel > Auto Add dans la barre de menus.
02 • Si vous sélectionnez "USBReader", connectez le lecteur de carte USB (le n ° de modèle du produit 
wiegand est WG1028) à l'ordinateur.
03 •  Cliquez sur "USB Reader" ou "Controller", puis cliquez sur "Next".

02. FONCTIONNEMENT DE BASE DU LOGICIEL 02. FONCTIONNEMENT DE BASE DU LOGICIEL
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FONCTIONNEMENT DE LA SECTION ET UTILISATEUR ENREGISTRÉ FONCTIONNEMENT DE LA SECTION ET UTILISATEUR ENREGISTRÉ
05 •  Si vous sélectionnez "Manual Batch Input", les cartes d'enregistrement seront ajoutées manuellement.
06 • Cliquez sur "Manual Batch Input", puis sur "Next".
07 • Tapez dans les zones "Start No." et "End No."
08 • Cliquez sur "Ok" à la fin de l'opération et les cartes d'enregistrement seront ajoutées au système.
Résultat, vous verrez les cartes d' inscription. Toutes les cartes enregistrées automatiquement le nom 
par défaut est "N + numéro de carte".

PERTE DE CARTE • ACCÈS AUX PRIVILÈGES

Si quelqu'un perd sa carte, il est nécessaire d'enregistrer la carte perdue, puis redistribuer une nouvelle 
carte à l'utilisateur.
01 • Cliquez sur Configuration > Personnel > Card Lost dans la barre de menus.

01 • Cliquez sur Configuration > Access Privilege dans la barre de menus.
02 • Cliquez sur "Change Privileges".

02 •  Tapez le nouveau numéro de carte dans la zone "New Card NO", puis cliquez sur "Ok".
Si la carte utilisateur dispose de privilèges, après avoir signalé la perte de carte, mettez à jour le 
contrôleur.

OPÉRATION
GESTIÓN DE PRIVILÈGES

02. FONCTIONNEMENT DE BASE DU LOGICIEL 02. FONCTIONNEMENT DE BASE DU LOGICIEL
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OPÉRATION OPÉRATION

03 •  ">>" Sélectionnez tous les utilisateurs ou tous les ports optionnels.
">" Sélectionnez un utilisateur ou une porte optionnelle.
"<" Annuler un utilisateur sélectionné ou une porte sélectionnée.
"<<" Annuler tous les utilisateurs sélectionnés ou tous les portes sélectionnées.

04 •  En cliquant sur "Allow" puis sur Operation> Upload, les utilisateurs sélectionnés peuvent accéder 
aux portes sélectionnés.
En cliquant sur "Allow and Upload", les utilisateurs sélectionnés peuvent passer par les portes 
sélectionnées.
Si vous cliquez sur "Prohibit", puis sur Operation> Upload, les utilisateurs sélectionnés ne peuvent pas 
utiliser les portes sélectionnées.
Si vous cliquez sur "Prohibit and Upload", les utilisateurs sélectionnés ne peuvent pas utiliser les portes 
sélectionnées.

05 • Après avoir ajouté tous les privilèges au système, cliquez sur Operation> Upload pour mettre à jour 
le contrôleur.

03 • Cliquez sur "Confirm and Upload" si vous avez ajouté des portes optionnelles ou annulé des portes 
sélectionnées pour mettre à jour le contrôleur et que l'utilisateur peut accéder aux portes sélectionnées.

• MODIFIER UN PRIVILÈGE D'UTILISATEUR
01 • Sélectionnez l'utilisateur et cliquez sur "Edit One User"
02 •  ">>" Sélectionnez tous les portes optionnelles.

">" Sélectionnez une porte optionnelle.
"<" Annuler une porte sélectionnée.
"<<" Annuler tous les portes sélectionnées..

02. FONCTIONNEMENT DE BASE DU LOGICIEL 02. FONCTIONNEMENT DE BASE DU LOGICIEL
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01 • Cliquez sur Operation > Console dans la barre de menus.

INFORMATIONS DU CONTRÔLEUR
01 • Cliquez sur Operation > Console > Check dans la barre de menus.
Résultat, s'affichent les informations de base du contrôleur, telles que le nombre de passes de cartes 
et de privilèges, l'état de la porte, l'état du contrôleur, etc. Si le contrôleur communique bien avec 
l'ordinateur, la couleur du port sera verte, sinon elle sera rouge.

CONFIGURER LE UPLOAD

01 • Cliquez sur Operation> Console> Upload dans la barre de menus.
02 • Cliquez sur "Ok".

CONSOLE CONSOLE

02. FONCTIONNEMENT DE BASE DU LOGICIEL 02. FONCTIONNEMENT DE BASE DU LOGICIEL
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CONSOLE CONSOLE

MONITEUR RECEVOIR DES ENREGISTREMENTS

CONSULTATION D'ENREGISTREMENTS

01 • Cliquez sur Operation > Console > Download And Monitor dans la barre de menus. 01 • Cliquez sur Operation > Console > Download dans la barre de menus. Collecte les enregistrements 
du contrôleur pilote pour la base de données.

Veuillez d'abord télécharger les enregistrements avant la consultation.
01 • Cliquez sur Operation > Query Swipe Records dans la barre de menus.

01 • Faites un clic droit et sélectionnez "Display More Swipes". Il ne montre que les enregistrements de 
glissement de carte.

MONTRER PLUS D'ENREGISTREMENTS

02. FONCTIONNEMENT DE BASE DU LOGICIEL 02. FONCTIONNEMENT DE BASE DU LOGICIEL
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CONSOLE FONCTIONNALITÉS
Si vous souhaitez filtrer les entrées et les sorties par "Addr", cliquez sur "Query Option".
02 • Cliquez sur "Query" pour afficher les enregistrements souhaités.

Vous pouvez changer le nom et le mot de passe de l'opérateur.
01 • Cliquez sur Tools > Edit Operator dans  barre de menus.

01 • Cliquez sur File > DB Backup dans la barre de menus.
02 • Cliquez sur "Ok".
Cette sauvegarde est enregistré sur le système par le chemin "C:\AccessControl".
Si la sauvegarde est SQL DB. La sauvegarde est enregistrée sur le système par le chemin "C:\Program 
Files\Microsoft SQL Server\MSSQL10.MSSQLSERVER\MSSQL\Backup".

FONCTIONNALITÉS
CHANGER MOT DE PASSE

SAUVEGARDE DE SECURITÉ A LA BASE DE DONNÉES

02 • Tapez dans les zones vides et cliquez sur "Ok".
REMARQUE: "New Password" et "Confirm Password" doivent être identiques. Après avoir modifié le mot 
de passe actuel, redémarrez le système et reconnectez-vous.

02. FONCTIONNEMENT DE BASE DU LOGICIEL 02. FONCTIONNEMENT DE BASE DU LOGICIEL
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FONCTIONNALITÉS FONCTIONNALITÉS

OPTION

03. FONCTIONNALITÉS ETENDUES

Vous pouvez modifier d'autres paramètres du système.
01 • Cliquez sur Tools > Language dans la barre de menus pour changer de langue.

Lorsque vous activez les fonctionnalités étendues, vous devez redémarrer le système.

02 • Cliquez sur "Interface Setting" dans la barre de sous-menu pour modifier l' interface.
House: Utilisé dans une gestion communautaire.
Show Getting Started When Login: Pour guider le logiciel d'operation.

03 • Cliquez sur "Auto Login" dans la barre de sous-menu pour activer la fonction.
Vous n'aurez plus besoin d'entrer "User Name" et "Password" pour vous connecter au système.

01 • Cliquez sur Tools > Extended Functions dans la barre de menus.
Tapez le mot de passe.
Mot de passe: 5678

02. FONCTIONNEMENT DE BASE DU LOGICIEL 02. FONCTIONNEMENT DE BASE DU LOGICIEL



18A 18B
FRFR

03. FONCTIONNALITÉS ETENDUES
DOSSIER

03. FONCTIONNALITÉS ETENDUES
CONFIGURATION

01 • Activez l'option "Active Log Query" pour activer la consultation des enregistrements.

ACTIVER LA CONSULTATION D'ENREGISTREMENT ENREGISTREMENT D'ÉVÉNEMENTS DE BOUTON POUSSOIR

Enregistre chaque fois que le bouton poussoir est utilisé.
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03. FONCTIONNALITÉS ETENDUES03. FONCTIONNALITÉS ETENDUES
CONFIGURATION CONFIGURATION

Vous devez connecter le capteur de la porte. Enregistre le temps de "Door Open" et "Door Closed".
REMARQUE: Après avoir activé n' importe quelle fonction, vous devez télécharger (Upload) la console.

ACTIVER PROFIL DE TEMPS

01 • Activez les options "Activate Time Profile" et "Activate Time Seg Limited Access".
02 • Cliquez sur Configuration > Time Profile dans la barre de menus.

03 • Cliquez sur "New" pour ajouter un nouveau profil horaire et ses caractéristiques.
04 • Tapez dans les zones vides et cliquez sur "Ok".

Resultat, en ajoutant une carte utilisateur "Normal", vous êtes autorisé à travailler sur le profil créé et 
vous pouvez vous connecter et vous déconnecter dans le délai fixé.
Après avoir défini les différents profils horaires souhaités, sélectionnez les autorisations correspondant 
aux utilisateurs dans Privilege Access.

ENREGISTREMENT D'ÉVÉNEMENTS DE L'ÉTAT DE LA PORTE
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03. FONCTIONNALITÉS ETENDUES03. FONCTIONNALITÉS ETENDUES
CONFIGURATION CONFIGURATION

ACTIVATION DU CONTRÔLE PÉRIPHÉRIQUE

01 • Activez les options "Activate Peripheral Control", "Threate Code Valid After RegisgterCard Swipe" et 
"Activate Open Too Long Wam".

02 • Cliquez sur Configuration > Périphérique dans la barre de menus.

03 • "Threat Code" :  doit être utilisé avec le lecteur de carte clavier PIN.
04 • Cliquez sur "Hardware Configuration".

05 • Déterminez les paramètres souhaités.
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03. FONCTIONNALITÉS ETENDUES03. FONCTIONNALITÉS ETENDUES
CONFIGURATION CONFIGURATION

ACTIVER L'ACCÈS AU CLAVIER
01 • Activez l'option "Activate Access Keypad".

02 • Cliquez sur Configuration > Pwd MGT dans la barre de menus.

03 • Déterminez les paramètres souhaités.
04 • Cliquez sur "Card+PIN" ou "PIN Code" ou "Controller's Password" ou "Manual Input Password", selon 
vos préférences.

REMARQUE: Dans le sous-menu "PIN Code", le mot de passe par défaut de l'utilisateur est 345978.
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03. FONCTIONNALITÉS ETENDUES03. FONCTIONNALITÉS ETENDUES
CONFIGURATION CONFIGURATION

ACTIVER ANTI PASS BACK

ACTIVER LE VERROULLAGE INTERNE

01 •  Activez l'option "Activate Anti Pass Back".

01 • Activez l'option "Activate Anti Inter Lock".
REMARQUE: cette fonction ne fonctionne que sur le MCA-02 à deux portes.

02 • Cliquez sur Configuration> Anti-Passback dans la barre de menus.

03 • Déterminez les paramètres souhaités.



23A 23B
FRFR

03. FONCTIONNALITÉS ETENDUES03. FONCTIONNALITÉS ETENDUES
CONFIGURATION CONFIGURATION
02 • Cliquez sur Configuration > Inter Lock dans la barre de menus.

03 • Déterminez les paramètres souhaités.

03 • Déterminez les paramètres souhaités, chaque groupe ayant deux utilisateurs ou plus ensemble peut 
ouvrir la porte en glissant leurs cartes ensemble.

ACTIVER L'ACCES AUX DIFFÉRENTES CARTES
01 • Activez l'option "Activate MultiCard Access".
02 • Cliquez sur Configuration > Multi-card dans la barre de menus.
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03. FONCTIONNALITÉS ETENDUES03. FONCTIONNALITÉS ETENDUES
CONFIGURATION CONFIGURATION

ACTIVER LA PREMIÈRE CARTE D'OUVERTURE
01 • Activez l'option "Activate First Card Open".

04 • Activez l'option "Active" et déterminez les paramètres souhaités.

02 • Cliquez sur Configuration > First Card dans la barre de menus.

03 • Sélectionnez l'utilisateur, puis cliquez sur "Edit".
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03. FONCTIONNALITÉS ETENDUES03. FONCTIONNALITÉS ETENDUES
CONFIGURATION CONFIGURATION

ACTIVER LA LISTE DES TÂCHES DU CONTRÔLEUR
01 • Activez l'option "Activate First Controller TaskList".

02 • Cliquez sur Configuration> Task List dans la barre de menus.

03 • Vous pouvez ajouter des tâches, cliquez sur "Add" ou modifier des tâches, cliquez sur "Edit".

04 • Déterminez les paramètres souhaités.
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03. FONCTIONNALITÉS ETENDUES03. FONCTIONNALITÉS ETENDUES
OPÉRATION MULTIFONCTIONS

ACTIVATION DE L'OUVERTURE DE LA PORTE A DISTANCE ACTIVER REPAS
01 •  Activez l'option "Activate Remote Open Door". 01 • Activez l'option "Activate Meal".

01 • Cliquez sur "Const Meal" dans la barre de menus.

02 • Cliquez sur Operation> Console dans la barre de menus.
03 • Sélectionnez d'abord la porte souhaité, puis cliquez sur "Remote Open".
Résultat, la porte sélectionnée s'ouvrira.

• CONFIGURER REPAS

• • LECTEURS
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02 • Cliquez sur "Meal Setup", puis sélectionnez le sous-menu "Readers".
03 • Déterminez les paramètres souhaités.

01 • Cliquez sur "Meal Setup", puis sélectionnez le sous-menu "Rules".
02 • Déterminez les paramètres souhaités.

01 • Cliquez sur "Meal Setup", puis sélectionnez le sous-menu "Meal Period".
02 • Déterminez les paramètres souhaités.

03 • Vous pouvez également définir la quantitée de consommation, cliquez sur "Option" et déterminez 
les paramètres souhaités.

03. FONCTIONNALITÉS ETENDUES03. FONCTIONNALITÉS ETENDUES
MULTIFONCTIONS MULTIFONCTIONS

• • RÉGLES

• • PÉRIODE DE REPAS
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• RAPPORT DE REPAS

• • RAPPORT DÉTAILS DES REPAS

• • RAPPORT DE L'ÉTAT DES LECTEURS • • RAPPORT D'ÉTAT DES UTILISATEURS

• • RAPPORT D'ÉTAT DE SOUS-TOTAL SECTION

01 • Cliquez sur "Create" et tous les détails du repas des utilisateurs seront affichés.

01 • Cliquez sur "Create" puis sélectionnez "Subtotal of Readers" dans le sous-menu et s'affichent les 
temps de  repas et dépenses classés par zone.

01 • Cliquez sur "Create" puis sélectionnez "Statistics" dans le sous-menu. Le temps et le total dépensé 
par chaque utilisateur seront statistiquement organisés.

01 • Cliquez sur "Create" puis sélectionnez "Subtotal of Department" dans le sous-menu et s'affichent les 
temps de repas et toutes les dépenses seront classés par département.

03. FONCTIONNALITÉS ETENDUES03. FONCTIONNALITÉS ETENDUES
MULTIFONCTIONS MULTIFONCTIONS
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03. FONCTIONNALITÉS ETENDUES03. FONCTIONNALITÉS ETENDUES
MULTIFONCTIONS MULTIFONCTIONS

ACTIVER LA PATROUILLE
01 • Activez l'option "Activate Patrol".

02 • Cliquez sur "Patrol" dans la barre de menus.

• CONFIGURER LA PATROUILLE

• • POINT DE PATROUILLE

• • REGLES DE PATROUILLE

01 • Cliquez sur "Patrol Setup".

02 • Réglez la porte sur "Patrol Point".

01 • Cliquez sur "Patrol Point", sélectionnez "Patrol Rules" dans le sous-menu et définissez les règles 
actuelles.
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03. FONCTIONNALITÉS ETENDUES
MULTIFONCTIONS

• • HOMME DE PATROUILLE

01 •  Cliquez sur "Patrol Point", sélectionnez "Patrolman" dans le sous-menu et définissez l'utilisateur 
qui est le patrouilleur.

03. FONCTIONNALITÉS ETENDUES
MULTIFONCTIONS

01 • Cliquez sur "Route".

02 • Cliquez sur "New" pour ajouter un itinéraire de patrouille.

03 • Déterminez les paramètres souhaités.

• ITINERAIRE DE PATROUILLE
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03. FONCTIONNALITÉS ETENDUES03. FONCTIONNALITÉS ETENDUES
MULTIFONCTIONS MULTIFONCTIONS

01 • Cliquez sur "Task" et définissez l'utilisateur qui fera l' itinéraire de patrouille. Assurez-vous d'obtenir enregistrement avant de créer le rapport.
01 • Cliquez sur "Create".

02 • Cliquez sur "Arange" puis sur "Ok".

02 • Cliquez sur "Query Option" et définissez le filtre souhaité.
03 • Cliquez sur "Query".

• TACHE DE PATROUILLE • RAPPORT DE PATROUILLE



32A 32B
FRFR

03. FONCTIONNALITÉS ETENDUES03. FONCTIONNALITÉS ETENDUES
MULTIFONCTIONS MULTIFONCTIONS

01 • Cliquez sur "Statistics".
Résultat, apparaîtra dans les statistiques d'état de l'homme de la patrouille.

01 • Cliquez sur "Address Setup".

01 • Activez l'option "Activate Meeting".

• STATISTIQUES DE PATROUILLE • CONFIGURER ADRESSE

ACTIVER LA RÉUNION
02 • Cliquez sur "Add" pour définir l'adresse de la réunion.
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03. FONCTIONNALITÉS ETENDUES03. FONCTIONNALITÉS ETENDUES
MULTIFONCTIONS MULTIFONCTIONS
03 • Entrez le nom de la réunion dans la zone "Meeting Address", définissez la porte, puis cliquez sur "OK".

01 • Cliquez sur "Add".

01 • Cliquez sur "Stat", les statistiques détaillées de la réunion souhaitée s'affichent. Vous pouvez filtrer 
par "Should", "In fact", "Leave", "Absent", "Late", "Total statistical" et "Calculate participants rate".

02 • Ajoutez la réunion en tant que réunion hebdomadaire, "Weekly Meeting" ou tout autre paramètre 
de votre choix.
03 • Identifiez les utilisateurs en tant que "Delegate", "Nonvoting Delegate", "Invitational","Audit", 

"Employee", et "Other".
04 •  Si vous souhaitez modifier la réunion, cliquez sur "Edit". Si vous souhaitez supprimer, cliquez sur 

"Delete" dans l' interface principale "Meetings".

• AJOUTER UNE RÉUNION

• ETAT DE RÉUNION
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03. FONCTIONNALITÉS ETENDUES
MULTIFONCTIONS

01 • Cliquez sur "Realtime Sign", s'affichera le temps réel dans la réunion.

• ENTRÉE EN TEMPS RÉEL

03. FONCTIONNALITÉS ETENDUES
MULTIFONCTIONS

• ACTIVER GESTION D'OPERATEUR

FONCTIONNALITÉS

01 • Activez l'option "Activate Operator Management".
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04. SERVICE
RÈGLES DE NORMALES PAR TOUR

02 • Cliquez sur "Tool", puis sur "Operator Management".

02 • Cliquez sur "Attendance", puis sur "Normal Shift Rules".

03 • Utilisez "New", "Edit", "Del", "Edit Previlege", "Groups" et "Zones" pour l'utilisateur.
04 • Cliquez sur "Edit Previlege" pour attribuer une opération et des privilèges de rôle aux utilisateurs.
REMARQUE: "abc" est l'administrateur de sécurité maximum par défaut. Vous ne pouvez pas utiliser "Del" 
ou "Edit Previlege".

01 • La fonction "Attendance" par défaut est active sur le système. Si vous souhaitez annuler cette 
fonction, activez l'option "Don't Display Attendance".

03. FONCTIONNALITÉS ETENDUES
MULTIFONCTIONS
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04. SERVICE04. SERVICE
VACANCESRÈGLES DE NORMALES PAR TOUR

01 • Cliquez sur "Attendance", puis sur "Holiday".

01 • Cliquez sur "Attendance", puis sur "Leave Business Trip".
VACANCES

VOYAGE DE TRAVAIL

02 • Déterminez les paramètres souhaités. 02 • Déterminez les paramètres souhaités.
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02 • Déterminez les paramètres souhaités.

04. SERVICE04. SERVICE
ENTRÉE MANUELLEVOYAGE DE TRAVAIL

01 • Cliquez sur "Attendance", puis sur "Manual Sign". 01 • Cliquez sur "Attendance", puis sur "Attendance Report".

ENTRÉE MANUELLE RAPPORT DE SERVICE

02 • Déterminez les paramètres souhaités.



38A 38B
FRFR

05. ANNEXE04. SERVICE
CONFIGURATION DU SERVER SQLRAPPORT DE SERVICE

02 • Cliquez sur "Create", puis sur "Ok".

03 • Cliquez sur "Statistics".

01 • Installez SQL Server puis configurez"Access Control SQL Server".
02 • Cliquez sur Operation> Programs> AccessControl> SqlSet.

03 • Cliquez sur "Test Conection", puis sur "Ok".
04 • Cliquez sur "Create Database", puis sur "OK". La base de données actuelle sera supprimée et une 
nouvelle sera créée.
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05. ANNEXE05. ANNEXE
IMPORTER INFORMATION DE CONSOMMATEUR PAR EXCELCONFIGURATION DU SERVER SQL

Vous verrez la base de données créée dans la barre système inférieure sous le nom "SQL: AccessData".

REMARQUE: Vous pouvez uniquement importer des informations valides sous "ConsumerNO", "Name", 
"CardID" et "Department".
01 • Cliquez sur Configuration > Personnel > Exporter to Excel.
02 • Choisissez le fichier dans lequel exporter les informations, puis cliquez sur Enregistrer.

05 • Cliquez sur Configuration > Personnel > Import.
06 • Cliquez sur "Ok", puis sur "Ok".

03 • Ouvrez le fichier Excel exporté, mentionné dans la fenêtre d’ information.

04 • Si le document contient déjà des informations sur les utilisateurs, vous pouvez les supprimer si vous le souhaitez 
et créer les nouveaux utilisateurs. Créez uniquement des informations sur "ConsumerNO "," Name "," CardID "et" 
Department ".
REMARQUE: dans Department, utilisez uniquement "\" comme séparateur. Par exemple: Sales Dep\Oversea Marketing.

IMPORTER INFORMATION DE CONSOMMATEUR PAR EXCEL
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Résultat, la base de données a été créée.

05. ANNEXE
IMPORTER INFORMATION DE CONSOMMATEUR PAR EXCEL


